Online Mathematics Diagnostic Tool
Documentation

September 2016
# Table of Contents

1. Introduction ........................................................................................................... 5  
   1.1 Purpose of this document ..................................................................................... 5  
   1.2 Scope of this Document ....................................................................................... 5  
   1.3 Project Overview .................................................................................................. 5  

2. Goals and Objectives .............................................................................................. 6  
   2.1 Objective .............................................................................................................. 6  
   2.2 Project Scope ........................................................................................................ 7  
   2.3 Usage of OMDT ..................................................................................................... 7  

3. History ..................................................................................................................... 7  

4. Accessibility .............................................................................................................. 8  
   4.1 OMDT hosted on Moodle ..................................................................................... 8  
   4.2 Moodle Security ................................................................................................... 8  

5. OMDT Design and Structure ................................................................................... 10  
   5.1 Design and Architecture of the Test ..................................................................... 12  
   5.2 Adobe Captivate Remedial Modules ................................................................. 15  

6. Development ............................................................................................................ 17  
   6.1 Module Test ......................................................................................................... 17  
      6.1.1 Moodle XML format and Latex .................................................................... 17  
      6.1.2 Question bank and category ......................................................................... 18  
      6.1.3 Adding a random question ............................................................................ 18  
      6.1.4 Assigning marks to questions ....................................................................... 18  
      6.1.5 Quiz Layout and Time .................................................................................. 18  
      6.1.6 Quiz Report .................................................................................................... 19  
   6.2 Remedial Modules ................................................................................................. 19  
      6.2.1 Remedial design and implementation ............................................................ 20
6.2.2 Steps to create advanced actions: ................................................................. 21
6.2.3 Apply advanced actions to slides ................................................................. 21
6.2.4 Remedial Interface ......................................................................................... 21
6.2.5 Configuring and Publishing to LMS ............................................................... 23

6.3 Moodle SCORM Package .................................................................................. 24
   6.3.1 Basic Report .............................................................................................. 24
   6.3.2 Graph report .............................................................................................. 24
   6.3.3 SCORM interactions report ........................................................................ 24
   6.3.4 Objectives report ....................................................................................... 24

6.4 Marksheet ............................................................................................................ 24

6.5 Plugins Added ..................................................................................................... 25
   6.5.1 Certificate Plugin ....................................................................................... 25
   6.5.2 Social Authentication .................................................................................. 27
   6.5.3 Progress bar ............................................................................................... 28
   6.5.4 Transcript ................................................................................................... 29
   6.5.5 Badge ........................................................................................................... 30

7 Implementation ....................................................................................................... 31
   7.1 Pilot and Implementation ............................................................................... 31
   7.2 Audit ................................................................................................................. 32
      7.2.1 External Auditors ....................................................................................... 32
      7.2.2 External Auditors Comments: ................................................................. 32
      7.2.3 Auditors Recommendations ..................................................................... 33
      7.2.4 Actions taken based on recommendations ............................................. 33
   7.3 OMDT Semester 1, 2016 Results .............................................................. 34
   7.4 Students’ Feedback on OMDT .................................................................. 37
      7.4.1 Students’ Comments: .............................................................................. 42
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8  Recommendation</td>
<td>42</td>
</tr>
<tr>
<td>9  Conclusion</td>
<td>42</td>
</tr>
<tr>
<td>10 Publications</td>
<td>43</td>
</tr>
<tr>
<td>11 Reference</td>
<td>43</td>
</tr>
<tr>
<td>Appendix 1: Certificate Implementations and Testing</td>
<td>45</td>
</tr>
<tr>
<td>Appendix 2: Social Authentication Implementations and Testing</td>
<td>48</td>
</tr>
<tr>
<td>Appendix 3: Guide to access OMDT</td>
<td>51</td>
</tr>
<tr>
<td>Getting Started</td>
<td>51</td>
</tr>
<tr>
<td>Locating OMDT on the Web</td>
<td>51</td>
</tr>
<tr>
<td>Log in</td>
<td>51</td>
</tr>
<tr>
<td>Registration</td>
<td>53</td>
</tr>
<tr>
<td>Forgot your credentials</td>
<td>57</td>
</tr>
<tr>
<td>OMDT Test</td>
<td>58</td>
</tr>
<tr>
<td>OMDT Quiz</td>
<td>61</td>
</tr>
<tr>
<td>Modules</td>
<td>62</td>
</tr>
<tr>
<td>How to attempt it?</td>
<td>63</td>
</tr>
<tr>
<td>Questionnaire</td>
<td>67</td>
</tr>
<tr>
<td>Certifications and Badge</td>
<td>67</td>
</tr>
<tr>
<td>Help and Support</td>
<td>67</td>
</tr>
</tbody>
</table>
1. Introduction

1.1 Purpose of this document

The purpose of this document is to outline the requirements, design and development of the Online Mathematics Diagnostic Tool (OMDT) while helping the client obtain a better understanding of the project. The intended audience for this document is the Learning Management System (LMS) Team at The University of the South Pacific (USP) and the Faculty of Science Technology and Environment (FSTE) Administration Office. Within this document, readers can find information about our general project concepts, a list of functional and non-functional requirements, examples of our graphical user interfaces (GUI), as well as information on the implementation schedule.

1.2 Scope of this Document

This document covers the functional and non-functional requirements of the OMDT project integrated within USP’s Learning Management System (Moodle).

1.3 Project Overview

The University of the South Pacific (USP) was set up in the South Pacific region in 1968 by its 12 member countries namely – Cook Islands, Republic of Fiji, Kiribati, Marshall Islands, Nauru, Niue, Samoa, Solomon Islands, Tokelau, Tonga, Tuvalu and Vanuatu. A total of 14 campuses are spread over an area of 30 million square kilometers of the Pacific Ocean. This geographical separation necessitates a commitment for USP to come up with better learning and teaching tools and a culture-inclusive curriculum.

The movement from secondary to tertiary education is not always easy. For some students the transition is smooth and clear but for others it is variable, with sub-optimal outcomes. An educational gap is created once a student leaves the secondary education system and joins the tertiary education system. Different levels of mathematics knowledge is brought by students, since they come from different assessment systems (i.e. Form 7, SPBEA curriculum, etc.) and hence different emphasis and importance are placed on different topics or areas of mathematics. This problem is further compounded by the in-experience, lack of relevant teaching qualification and weak mathematics background teachers. Another problem faced is limited resources such as textbooks and teaching materials. Most of the programmes offered at USP have some mathematics component and hence comparing the mathematics taught in the Pacific Region in Year 12 and Year 13, few topics in the curriculum have been over-seen and discarded as compared to that taught at tertiary level. To bridge this numeracy gap from secondary to tertiary level mathematics education the Faculty of Science, Technology and Environment (FSTE) developed the Online Mathematics Diagnostic Tool (OMDT) in 2011.
The OMDT progressively outlines different topics of mathematics taught at Year 12 and Year 13 level in all the member countries of USP. The OMDT is an ICT enabled tool designed to diagnose and detect students’ weakness in different areas of mathematics (Algebra, Functions, Differentiation, Integration, Statistics and Probability). It is an intelligent system which directs students to relevant online remedial, based on their online test performance i.e. automated pathways. Since most undergraduate courses requires some level of mathematics hence OMDT provides appropriate online remedial that will help students and ensure that they are prepared for their degree level mathematics and mathematics related courses.

The OMDT consists of a test and five remedial modules. The test consists of five Modules, each having eight questions, giving a total of 40 questions for the entire test. The questions type are multiple choice, matching and true or false. The questions are randomly picked from five banks containing a total of 1500 questions. The duration of the test is 75 minutes. The questions are taken from the five broad topics: Algebra, Functions, Differentiation, Integration and Probability & Statistics. The test diagnose students’ weaknesses in these topics, give instant results and feedback and also direct students to the appropriate remedial if the need arises. The remedial is developed using the Adobe Captivate software which allows the use of edutainment features such as videos and gaming. After completing the OMDT, students are required to fill in a questionnaire as a condition for getting their certificates, badges and transcripts.

The OMDT is hosted the Modular Object-Oriented Dynamic Learning Environment (MOODLE) platform, which is an open source eLearning software, widely recognized as the Learning Management System (LMS) or a Virtual learning environment. Students can access the OMDT from anywhere around the world using computers, laptops, smart phones or tablets with internet connectivity.

2. Goals and Objectives

This projects attempts to outline the major areas of weaknesses faced by students in Mathematics by means of an online test. OMDT aims to diagnose any areas of weaknesses found in participating students and to provide fully functional online remedials to prepare students for undergraduate programs at USP.

2.1 Objective

The objectives of the project were to:
- Develop a tool that can be accesses from anywhere in the world
- Develop a test that will provide instant feedback
- Develop an intelligent system that will direct students to the appropriate remedial
- Develop an engaging and interactive remediation
- Allow students to re-test the areas they initially failed
- Develop a system that ensures that the students feedback is captured
- Provide badge, certificate and transcript as evidence of programme completion
• Provide automated analysis for reporting purposes

2.2 Project Scope

• Content covers mathematical concepts learned in Y12 and Y13 secondary school level
• Test was built on Moodle using Moodle Quiz feature
• The test question types are multiple choice, matching and true or false
• Remedial was developed using Adobe Captivate software
• Tool is hosted on the MOODLE platform
• The tool can be accessed online from anywhere using a computer, laptop, smart phone or tablet with internet connectivity

2.3 Usage of OMDT

OMDT is used to find out the mathematics knowledge of a student and help them in their weak areas of mathematics. The users of OMDT are:

• Students – tests own mathematics skills and discovers the weak areas
• Course Coordinators – discover student’s mathematic knowledge and also use OMDT to give remedial to students in certain topics.
• Sponsors – discover how their students fare in terms of mathematics
• Campus Directors - discover how their students fare in terms of mathematics

3. History

The work on OMDT began in 2011. This included research on mathematics diagnostics test offered by various universities, creation of test questions, moderation of the test questions by the School of Computing, Information and Mathematical Sciences (SCIMS) senior staff and development of the online test. The online test was piloted to FSTE first year students both in Laucala campus and in the region in 2013. Also this year the content of the remedial was created, which was also moderated by SCIMS staff and the online remedial was developed. The online remedial was piloted in 2014. The OMDT was audited internally by USP staff and students’ feedback was sorted. Due to recommendation from the internal audit and comments from students, the OMDT team researched and trialed out various plugins and created more contextualized questions.

In 2015 the team developed a new improve version of the OMDT. The OMDT was audited externally and the report from the external auditors was very positive with minor recommendations for improvement. The team considered the recommendations and took on board the ones which suited the purpose of OMDT. A fully functional OMDT product is now live.
4. Accessibility

The OMDT is available in the OMDT website www.omdt.usp.ac.fj. USP students can login with their USP username and password. OMDT has the social authentication feature which also enables anyone to login to OMDT with their Gmail or Facebook account. OMDT is accessed by students from USP’s different facilities, schools and departments. Different facilities has different OMDT shell with desired level of questions.

The steps to access the OMDT is given in the Appendix 3 section.

4.1 OMDT hosted on Moodle

To ensure effective and efficient learning, the OMDT team has chosen the Modular Object-Oriented Dynamic Learning Environment (MOODLE) as its primary content delivery platform. MOODLE allows education professionals to act as facilitators of learning and both facilitators and learners to actively participate in its content.

The OMDT is housed in a different server and MOODLE which is independent from USP’s elearn platform (elearn.usp.ac.fj). The reason why OMDT is hosted on Moodle is that it adopts all its security features which makes the OMDT secure from hacking and manipulation of quizzes and grades.

All mathematical questions are prepared on MOODLE using LateX programming skills for better readability. Since MOODLE is an open source e-learning software, widely recognized as a Learning Management System (LMS), it serves its purpose well with the aims and objectives of OMDT. All questions are delivered to students using the ‘Quiz’ tool where students can have access to their results immediately after completing the test. Based on these results, the system automatically indicates which remedial a particular student requires with the help of ‘conditional activities’ in MOODLE.

4.2 Moodle Security

Since Moodle is used by many trainers and trainees, it can be accessed from anywhere at anytime on many devices. Because of these threats can be an issue, such as alter of grades, motivation to know others grade. Threats can be outsiders (hackers, former employees) and insiders (users, programmers etc). Some attacks such as impersonating valid users, trial and error of simple user name and password, SQL injection attacks, wiretapping can be done to the system and some of the possible attacks on Moodle can be tampering grades, quiz time, accessing quizzes before time, login as other users, DoS etc.

Since OMDT is running on MOODLE 2.9 version it adopts all the security feauters which makes the OMDT secured from hacking and manipulation of grades and quizzes. The feauters are:
• Access control
  o Strong passwords and secure logins
  o Minimum access (administrators/ Lecturers/ Tutors/ Students/ Guests )
  o Policies that address what, by whom , when

• File and data control
  o Integrity and confidentiality
  o Separation
  o Backup and policies

• System Protection
  o Firewalls, antivirus, IDS
  o Frequent updates
  o Minimal services

• Securing Moodle server and site
  o Server-level security and application level security (Block SQL injection attacks and cross site scripting)

• Backup at all levels
  o Course backup
  o Moodle data folder
  o SQL data
  o Server backup

Moodle system also can do Monitoring, Accounting and Auditing of users logs. The following logging reports can be done:
• Moodle logs
  o My course> Course name> Reports>Logs, Activity, Participant reports
  o Moodle Statistics
  o PHP log
• Web server
  o Server log
  o Server statistics
  o /user/local/apache/logs,/var/log/apache Or /var/log/httpd
• Operating system log
  o /var/log/syslog, /var/log/messages
• Firewall and IDS log
• Use log analysis tools
5. OMDT Design and Structure

When a student first logs in to the OMDT homepage, only the introduction and instructions will be viewable. The rest of the stages are locked based on certain completion criteria. After reading the instructions, watching the video and going through the procedure, only then will the first section of the test i.e. module 1 be unlocked (viewable). The students are given 15 minutes to complete each modules. The test consist of five Modules which should be completed within 75 minutes. After student’s complete module 1, then module 2 will be unlocked (viewable) and students will receive a message informing them to continue attempting module 2 straight away. This sequence occurs until student’s complete module 5. When students pass a module, they are awarded two stars. If they fail the module, a message will be displayed notifying them that the remedial will be available at the end of the test or after completing module 5.

After completing module 5, students are directed to fill in the test questionnaire. For students who have passed all the five modules filling the questionnaire is a condition for receiving their badges, certificates and transcripts. Students who fail at least one module are directed to take the appropriate remedial. After completing a remedial module, based on the condition of obtaining a minimum mark of 50% in the exercises, a new link for the retest will appear. This will allow students to reattempt only the module of the test that they failed. This also serves as an indication to whether or not the remedial was of any help to the students. If students pass or fail the retest, they are required to fill in the remedial questionnaire, then the module questionnaire before they can access their badge, certificate and transcript. A detailed flowchart of the OMDT is given below in Figure 1.0.
Figure 1: Flowchart Showing Different OMDT Processes
5.1 Design and Architecture of the Test

The OMDT test consists of five modules or sections. One module for each topic: Algebra; Functions; Differentiation; Integration and Statistics & Probability. The test questions are taken from five question banks. One bank for each module. Each question bank has 3 sub banks of easy, intermediate and advance questions and thus for each module, 4 easy, 2 intermediate and 2 advance questions are randomly generated and presented to the user as test questions for the module. So there are eight questions for each module and 40 questions altogether for the test. The questions are randomly selected so that no two students can view the same set of questions at any point in time. The answers are also shuffled within the multiple choices ensuring that even if two students obtain the same question, the choices are differently ordered. The questions which are pulled from the question banks are tracked and the results of each question attempt by any user or multiple users will appear in the MOODLE marksheet.

The design and architecture of the test which has been developed in MOODLE is given below in Figure 2.0. This clearly shows how the random questions are generated from the question banks.
Figure 2: Design of the OMDT Test Module
Figure 3: Test Architecture showing how questions are randomly selected from different question banks.
5.2 Adobe Captivate Remedial Modules

The remedial is designed to be engaging and interactive. The remedial modules are developed using the Adobe Captivate software. Adobe Captivate allows to the use of edutainment and gamification features, the use of videos and games. The five remedial modules consist of the following topics: Algebra, Functions, Differentiation, Integration and Statistics & Probability. The remedial consist of notes, examples, videos and exercises that help students refresh their knowledge on the assessed topics. The remedial only appear to students who score below 50% in a particular test module. During the remedial, a student can stop at any point and resume from where they left off. There is a progress bar that indicates the percentage a student has completed or is yet to complete.

The exercises known as Test Yourself, tests the students’ knowledge of how much they have learnt in the remedial. Every subtopic of the remedial has a question bank and questions are randomly picked for the Test Yourself exercises. Students are allowed one attempt per question and upon failure, they will be directed to certain components in the remedial that will provide remediation on where they went wrong.

Next, the students will be required to attempt another similar question. However, when the students pass any attempt, they will continue with the next subtopic. The remedial flowchart given in Figure 4.0 shows the processes of a remedial module.

Upon completion of each exercise students gain coins. The number of coins is reduced with increased attempts per question.

At the end of the remedial the total coins gained is converted to marks and the marks determine if students pass or fail the remedial. If students pass the remedial, they will continue to do the retest module, if not they will be required to do the remedial once again (only 2 attempts allowed).
Figure 4: Remedial Flow Chart for one Remedial Module
6. Development

6.1 Module Test

OMDT questions were designed and built using Moodle quiz activity module. The Quiz activity module consist of a large variety of question types, including multiple choice, true-false, short answer, matching, drag and drop images and text. OMDT questions are multiple choice, true-false and matching. These questions are kept in the question bank and is used and reused in different quizzes. As stated in section 5 Design and Architecture, each question bank has 3 categories: easy, intermediate and advance. Total of 5 question bank are made with its 3 sub categories.

6.1.1 Moodle XML format and Latex

The XML Format is a Moodle-specific format for importing and exporting questions to be used with the Quiz module. To add bulk of questions in question bank, the questions are developed in VLE tool which is a Moodle XML convertor and mathematics equations are written in latex format before importing it into question banks. This converter supports Moodle question types which are: multiple choice, short answers, essay, true/false, numeric, matching and description. There are some reserved words used when writing quiz in VLE Tool. This reserved words builds the structure for quiz, which are:

<table>
<thead>
<tr>
<th>Reserved Words</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer:</td>
<td>Correct Answer</td>
</tr>
<tr>
<td>gfeed.</td>
<td>General Feedback</td>
</tr>
<tr>
<td>feed.1.</td>
<td>Feedback for answer variants</td>
</tr>
<tr>
<td>feedback:</td>
<td>Feedback for only correct answer</td>
</tr>
</tbody>
</table>

*Table 1: Table showing reserve words for Test Module creation*

The following steps are done to prepare a XML text file:
- Set Question type
- Define answers variants. i.e.
  ```multichoice
  Question 1
  A. TextAnswer 1
  B. TextAnswer 2
  C. TextAnswer 3
  Answer: B
  ```
  ```
  Question 2
  A. TextAnswer 1
  B. TextAnswer 2
  C. TextAnswer 3
  ```
• The Math’s equation must be in Latex format. E.g.

\[ \int_{a}^{b} x^2 \, dx \]

• Once entire questions are added in the text file, import the file in Moodle question bank as stated under Question bank and category section.

6.1.2 Question bank and category

The quiz bank with questions were built using category, manual editing quizzes and importing Moodle XML format file, category was created first, click “Course administration > Question bank > Categories > Add category.” Once category is added, click import under “Question bank” and click Moodle XML format under file format and choose the located XML file that is created. The imported quizzes are selected and moved to its respected categories, by selecting the check boxes and clicking the “move to>>” button. The other 4 banks and its sub banks were created similarly.

6.1.3 Adding a random question

Random quiz was put in place so class taking quiz at the same time don’t get same questions. Random question was added from the question bank that was created as mention. A quiz was created by clicking Add an activity or resources > Quiz > click the quiz that is created > Edit quiz > Add > + a random question > Random question from an existing category > category > number of random questions. For instance creating question for Function module, 4 random questions were selected from easy category, and step from Add > + a random question > was followed to add other 4 questions from (2) intermediate and (2) advance category.

When a quiz with random questions is retaken, the random questions will be different from the ones in previous attempts. The grade for the randomly chosen question is rescaled so that the maximum grade is what you have chosen as the grade for the random question. [2]

6.1.4 Assigning marks to questions

Each question in the question bank is assigned 2.5 marks each. A total of 20 marks is assigned per module. When adding questions using randomization technique, only assign points to 8 questions that are added. The system will automatically assign points to all the questions in the bank. To do this Administration > Quiz administration > Edit quiz > Editing quiz. Set marks in each added question by changing the number in the box to the right of each question and change the maximum grade by changing the number in the box top right at the top of the quiz.

6.1.5 Quiz Layout and Time
Two question per page is set as an apperance with time duration of 15 minute per module. As the time will expire the quiz will be automatically submitted and the mark will be added to marksheet. Layout setting: Administration > Quiz administration > Edit settings > Layout whether to have a new page for every question or after a certain number of questions.

6.1.6 Quiz Report

Grade reports shows all the students' quiz attempts, with the overall grade, and the grade for each question. Different kind of information can be obtained from the report and downloaded in variety of formats such as XML, excel sheets and etc. The information are:

- Enrolled users who have attempted the quiz;
- Enrolled users who have not attempted the quiz;
- Enrolled users who have, or have not, attempted the quiz;
- All users who have attempted the quiz

There are check boxes to allow individuals regrade or delete the selected attempts. By clicking on the score link, you are able to look at an individual student’s exam. The reports allows the admin to manually grade the reports, which will be useful if ever the need to edit the grades by hand arises.

6.2 Remedial Modules

All 5 remedial modules are developed to be interactive and engaging using adobe captivate software. Captivate allows the use of edutainment and gamification features, the uses of videos and games. The remedials consist of notes, examples, videos and exercises that help students refresh their knowledge on the assessed topics. These remedials are for Algebra, Functions, Differentiation, Integration and Statistics & Probability. Remedials will only appear to students if they score below 50% in a particular module. During the remedial, a student can stop at any point and resume from where they left off. There is a progress bar that indicates percentage a student has completed or has yet to complete. The exercises known as “Test Yourself”, tests the students knowledge of how much they have learnt in the remedial. A student is only allowed 1 attempt per question and if the student fails the first attempt, they will be redirected to certain components in the remedial that will provide remediation on where they went wrong. Next, the student will then be redirected to another similar question and the same scenario applies if the student fails. However, when the student passes any attempt, they will continue on into the next subtopic. Refer to the remedial flowchart below (Figure 4.0). Upon completion of a remedial activity, students will get coins.

The number of coins depends on the number of times a student attempt the remedial test. The Remedial has 3 levels of test, 1st attempt is “Test Yourself”, 2nd attempt is “Retest 1”, a student will get “Retest 1” if they fail the 1st attempt (Test Yourself), and if a student fails the 2nd attempt (Retest 1), they will be given a final attempt that is “Retest 2”. The 3 levels of test is set with different number of coins: 1st attempt is set with 15 coins, 2nd attempt is set with 10 coins and the 3rd attempt is set with 5 coins. If a student attempts the test of a subtopic once, they get the maximum number of coins for that test. If students pass the remedial, they will be directed to take a retest of the failed
Module. Students therefore get a maximum of 2 attempts per module. The reason behind having two separate quizzes is to keep track of the students performance in both attempts ensuring that marks are not overwritten in the marksheet. This also serves as an indication to whether or not the remedial were of any help to the students. If the student fails the remedial, they will be given another attempt. A maximum of 2 remedial attempts are given to the students, and if the students fails the second attempt, they will still be able to proceed to the respective module retest. Remedial are added to Moodle using SCORM (Sharable Content Object Reference Model) package.

6.2.1 Remedial design and implementation

As stated in the above section all 5 remedial are design and developed in Adobe Captivate. Each component of the remedial has different master slide based on the same theme. A total of 7 slides are designed under the same theme, and these are: splash slide, dashboard, notes, examples, videos, exercises/test and coin slide. Listed below are the slides and their component:

- Splash Slide- Consists of title and sub title of the remedial.
- Dashboard- Consists of all the components link, which will direct the users to their desired slides.
- Notes- Consist of topic and sub topic notes.
- Examples – Consists of sets of topics and sub topics examples. Multiple examples are added to this slide with a click on its respective tabs/buttons.
- Videos- Consists of videos related to topic and sub topics.
- Exercise/Test- Consists of 3 level of remedial test.
- Coin- This slide shows the coins a student gets depends on their performance.

Each slide consists of buttons which directs the student to respective slides upon clicking. The buttons are designed through the development of standard and conditional scripts. The scripting for the advanced actions model in Adobe Captivate is based on the Object-Event-Action model. Events on an interactive object, such as mouse-clicks, trigger actions that are defined for that event. Scripts were written to handle complex interaction scenarios and were applied to various interactive objects. The two type of actions used were standard and conditional based. Conditional action was used to detect if the desired component is completed or not. Checkbox was used to show if students have completed the task. The condition action was developed using Provide if … else conditions with 'and', or 'or' operators when scripting actions.
Standard action was used as a single script to run multiple actions in a sequence. The actions that were used to script were; show, hide, assign, jump to slide, continue etc. Attached is the screen shot of a standard action.

![Figure 5: Conditional action Script]

![Figure 6: Standard action script]

6.2.2 Steps to create advanced actions:

1. Select Project > Advanced Actions.
2. Select the action type:
3. Conditional Action
4. To create an if … else condition for your script.
5. Standard Action
6. To customize one of the predefined actions in Adobe Captivate.
7. In the Action Name, specify a name for the action.
8. Click the add icon.
9. Complete writing the code with the supplied options. Any option that has not been assigned a value is indicated by the red icon. If you do not set these values, it results in an error when you try to save the script.
10. Click Save to save the script.

6.2.3 Apply advanced actions to slides

1. In the Property Inspector (Window > Properties), go to Action.
2. Select Execute Advanced Actions.
3. In Script, select the script that you want to run from the Action menu.

6.2.4 Remedial Interface

The interface was design in responsive view using images, icons, animations, buttons, texts, voice and inbuilt interactions. Four slide are attached below.
Figure 7: Example interface

Figure 8: Dashboard interface

Figure 9: Test interface

Figure 20: Coin interface
6.2.5 Configuring and Publishing to LMS

Before uploading to project that is developed in Moodle through SCORM, it must be configured and published. Steps in configuring the project to report to Learning Management System (LMS):

- **Project**, select *Quiz > Quiz Preferences*. The Preferences dialog box appears with the Quiz Reporting category open.
- Category: *Quiz > Select Enable reporting for this project and then select one of the options in the LMS list.*
- LMS: *Moodle > Standard: SCORM 1.2 > Template: Default*
  Specify how you want the status of the course to be reported to LMS. (For this project, *Incomplete → Passed/Failed was selected*)
- Specify the success and completion criteria for your course. The status of the course is decided based on whether users met these criteria. (For this project, *Slide views and/or quiz > Quiz > Quiz is Passed was selected*).
- Data to Report > *Quiz Score > Percentage > Interaction Data>*
- Category > *Quiz > Select Pass or Fail > Pass/Fail Options: > enter the passing mark or percentage. (For this Project, *points or more to pass was selected*). Note: Every project has certain marks to pass.
- Sets you attempts and enter *OK*

Steps in publishing the project on Learning Management System (LMS):

- Select *File > Publish.*
- In the *Publish as* drop-down, select *HTML5/SWF.*
- In the *Project Title*, enter the name without the filename extension (.swf).
- In the *Folder* text box, enter the full path to the folder in which to save the file or click *Browse* to locate the folder. (By default, *Zip Files is selected as the output option. Adobe Captivate packages the course into a PIF by creating a ZIP file containing the Flash (SWF) file and the HTML file.*)
- Click *Publish.*
- After publishing the project, upload the ZIP file to Moodle through SCORM.

Steps to add Published file to SCORM:

- Add an activity or Resources in Moodle
  - *ACTIVITIES > Select SCORM package*
- Fill in required sections and upload ZIP published file
- Set the required settings under *Attempts management, Compatibility settings, Restrict access* and *activity completion.*
6.3 Moodle SCORM Package

SCORM is a collection of specifications that enable interoperability, accessibility and reusability of web-based learning content. SCORM content can be delivered to learners via any SCORM-compliant Learning Management System (LMS) using the same version of SCORM. [2]

SCORM allows access of 4 types of reports to the OMDT team. Those reports are:

- Basic report
- Graph report
- Interactions report
- Objectives report (for SCORM packages that use objective reporting)

6.3.1 Basic Report

The basic report page shows a table of attempts for the SCORM activity and this report is downloaded in ODS, Excel or text format. A detailed report of each user's attempts can be obtained by clicking on the number in the attempts column. The track details link provides information on specific SCORM values recorded in Moodle by the SCORM object. [2]

6.3.2 Graph report

The graph report displays graphs of percentage obtained against number of participants. [2]

6.3.3 SCORM interactions report

The interactions report shows students' responses to questions together with the correct answers. The interactions report can be downloaded in ODS, Excel or text format and include responses, right answers and results (whether the response to a question was right or wrong). [2]

6.3.4 Objectives report

This report is similar to the interactions report but if a SCORM package is set up to report objectives then this report will display the status and raw. Score of any objectives data will be passed back to Moodle.

6.4 Marksheet

The marksheet is restructured and a formula is introduced for the total to sum up the quiz and the retest marks. The following steps are taken in calculating the total course mark:

- 5 categories are created based on the topics. Steps to create category:
  - Course administration > Grades > drop down to Categories and Items > Scroll down > Add category > Fill the Category name > Aggregation > Natural > Save changes.
- Each category has a Quiz and Retest mark. Steps to assign items in category:
  - Select radio button of desired item under Select Column, Scroll down, Choose the category under Move selected items to > Select the Category.
- Add ID to each Item in the mark sheet. Steps:
  - Click the Edit of the Category that is created, Add ID under ID numbers, Scroll down, click Add ID numbers, once ID is created fill the Calculation field, Add formula.
- The highest score between the quiz and the retest becomes the mark of the category.
- The category marks are summed up to give the final course mark.

6.5 Plugins Added

As OMDT is housed in a separate server and MOODLE, the team can customize and trial out new plugins. Some plugins were customized to meet the objective of OMDT. The added plugins are:

6.5.1 Certificate Plugin

Once student completes OMDT, an automated FSTE OMDT downloadable certificate (pdf format) is available to students on the OMDT shell on Moodle. The certificate is divided into four levels: distinction, credit, pass and participation. The four levels are based on mark ranges similar to USP’s grades mark ranges (distinction: 78+; credit: 64-77; pass: 50-63; participation: 0-49). The certificate code is customized according to USP’s theme design and grading category.

The certification process involves setting up proper conditions for the test activities, formula for marksheet and also requires a certificate module to be used in the OMDT shell. The end product is
a customized FSTE OMDT certificate in pdf which is available for a student to view and download and the level of certificate is based on the final course mark the student has obtained.

The code below defines the four level of attainment:

```php
function certificate_get_level($grade) {
    if($grade == ' '){ //If user does not have any mark in marksheet
        $level = 'title_completion';
        return $level;
    }
    else{ //If user has mark in marksheet
        if($grade >= 0.00 && $grade < 50.00){
            $level = 'title_participation';
            return $level;
        }
        elseif($grade >= 50.00 && $grade < 64.00){
            $level = 'title_pass';
            return $level;
        }
        elseif($grade >= 64.00 && $grade < 78.00){
            $level = 'title_credit';
            return $level;
        }
        else{
            $level = 'title_distinction';
            return $level;
        }
    }
}
```
The entire testing module, production of certificate plugin and a sample is attached in the Appendix 1.

6.5.2 Social Authentication

The use of this plugin allows anyone to login to OMDT Moodle using their existing social media account – Facebook or Google mail. When users login via social media for the first time, they are required to fill in their personal information in a form. If the form is not filled then the user cannot proceed to use the OMDT site.
The entire testing module and production of social authentication plugin is attached in the Appendix 2.

6.5.3 Progress bar

Adding the progress bar shows the users their progress. This plugin allows facilitators to see the progress of all students enrolled in OMDT, which is helpful for finding at-risk students. Students can also see their own progress in different modules. Features of this plugin are:

- It is colour coded so students can quickly see what they have and have not completed/viewed.
- The Progress Bar is a time-management tool for students.
- The facilitator selects which pre-existing activities/resources are to be included in the progress bar and when they should be completed/viewed.
- It visually shows what activities/resources a student is supposed to interact with in a course.
6.5.4 Transcript

The certificate plugin was extended for transcript. The automated and downloadable OMDT transcript is available to students in the OMDT shell on Moodle. Once a student complete the OMDT modules, the student is eligible to get a transcript. The steps to obtain the transcript are similar to the steps to obtain the certificate. The transcript provides details of the grades achieved for each module test and retest. The grades are similar to USP’s grading range and are displayed in a row and column format.

The end product is a customized FSTE OMDT transcript in pdf which is available for a student to view and download.
6.5.5 Badge

Together with the certificate and transcript, a badge will be issued to students indicating that they have completed the OMDT. A set of criteria is set for the badge to be awarded and only if all the conditionals are met by the student then the badge is awarded. The badge was created and added on Moodle. For certificate and transcript, a student can save and download it in pdf format, but for a badge a student cannot download it. Instead, it will be placed on the top corner of the OMDT site and displayed on a user’s profile. Obtaining a badge is a good way to celebrate ones achievement and show their progress.
7 Implementation

7.1 Pilot and Implementation

The OMDT has been trialed to students for a couple of semesters as given in the table below. To trial out OMDT, the team decides on the dates in which they will open the OMDT to students. This is usually during the orientation week and the first week of lectures. Emails are sent to Campus Directors to avail the computer labs for students to use. An image slider is created and placed in the USP main page informing the University community about the open dates. Course coordinators are informed to encourage their students to take the OMDT. A user manual is created for students to use when attempting the OMDT. An email is sent to students on what OMDT is about, why they need to take OMDT and how they can access the OMDT using the user manual. The link http://www.usp.ac.fj/index.php?id=omdt is also sent to students for further information.

<table>
<thead>
<tr>
<th>Year</th>
<th>Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>2012</td>
<td>online test-FSTE first year students</td>
</tr>
<tr>
<td>2013</td>
<td>online test-FSTE first year students and Foundation students</td>
</tr>
<tr>
<td>2014</td>
<td>online test online test-FSTE first year students and Foundation students&lt;br&gt;online test is part of the course work for all first year mathematics and statistics courses in Semester 1</td>
</tr>
<tr>
<td>2015</td>
<td>online test and remedial-FSTE first year students and Foundation students</td>
</tr>
<tr>
<td>2016</td>
<td>online test and remedial-FSTE first year students and Foundation students&lt;br&gt;online remedial is part of the course work for selected first year mathematics and statistics courses in Semester 1&lt;br&gt;online test and remedial is part of the course work for selected courses in FSTE, Faculty of Business and Economics and Pacific TAFE.</td>
</tr>
</tbody>
</table>
7.2 Audit

The OMDT went through several audit stages.

1. The content of the test and remedial were first audited by the senior staff of the School of Computing, Information and Mathematics before the content was placed online.
2. After the online test and the online remedial were created, it was audited again by the senior staff of the School of Computing, Information and Mathematics Sciences.
3. Next students intern were hired to go through the OMDT using the user manual and report any confusion they face or report on any image that looks confusing.
4. Finally the OMDT was audited externally.

The team compiled the audit reports, discussed the recommendations and implemented the ones suitable for the OMDT.

7.2.1 External Auditors

The OMDT was audited externally. Given below is the list of external auditors.

- Professor Abtar Kaur, PhD, Dean, School of e-Education, Hamdan Bin Mohammed Smart University, Dubai
- Professor Junhong Ha, PhD, Korea University of Technology and Education, Cheonan, Korea
- Ms. Cheryl McKeeman, Math/Stat Advisor, Department of Mathematics & Statistics, Langara College, Vancouver, British Columbia, Canada
- Professor Sunday A. Reju, PhD, Director, Department of Mathematics and Statistics, Faculty of Health and Applied Sciences, Namibia University of Science and Technology, Namibia

7.2.2 External Auditors Comments:

- Took the Statistics Test. The test was Good.
- The remedial material is Very Good. Essentially you have an entire first month of a college course there.
- The OMDT at USP is a truly innovative attempt. The overall design of the test is very well structured. The aesthetics are well planned. A lot of effort has been taken to provide the test in a sound manner that can be highly appreciated.
- It is an excellent method to train the power of making them understand the new concept.
- Remedial Moderation Block (Auditor) is wonderful. You did a good job.
- The OMDT is a very great project and the efforts put into its design and development is highly commendable.
- A Laudable effort on the system that has a provision to show the answers and the right answer.
7.2.3 Auditors Recommendations

- Change in the order of the topics in the test. Two different orders were suggested.
- Replace the use of ‘single finger’ as symbol of direction with an arrow.
- Enlarge the text under the single finger to be readable.
- The number of questions to be answered may be made odd number, eg. 7 or 9 so that students get a clear pass or fail outcome.
- Student should be able to skip some section of the remedial.
- It is recommended that the review page of the relevant content links to be made available after students give a wrong answer.
- A click here text can be added to indicate to the student to click on the Review.
- Recommend replacing the Warning! text with Alert or Notification.
- By design or accidently, the structure is such that a student is allowed to go back and re-answer.
- To show the correct answer after the third attempt of the remedial exercise. The remedial can be completed with a minimal set of questions being correct.
- If the user fails in the test (re-test) again, what happens is not clear.
- There can be external links to explain various terms.
- Consistency of symbols, terms and processes used in different remedial modules.
- Remove high level content such as integration trigonometric substitution.
- Increase time for the test

7.2.4 Actions taken based on recommendations

The team discussed the recommendations and implemented only the ones that suited the purpose of OMDT.

- The order of the test Module was changed to: Algebra, Functions, Differentiation, Integration and Probability and Statistics.
- The ‘single finger’ as replaced with the arrow.
- The text under the arrow was enlarged.
- A new improved version of the remedial was created which catered for the recommendations.
- When a student fails the retest, he is allowed to receive his certificate which is the certificate of participation.
- The test time was increased from 60 minutes to 75 minutes.
Figure 18: Graph showing the overall percentage pass and failure rate for each Module test in Semester 1, 2016.
Figure 19: Graph showing the number of students who attempted the test from each Campus and how many of these students pass and fail in Semester 1, 2016.
Figure 20: Graph showing the average percentage mark obtained by students from each campus for each Module in Semester 1, 2016.
Figure 21: Graph showing the number of students enrolled in MA, ST and UU courses who attempted OMDT and those who pass and fail in Semester 1, 2016.

7.4 Students’ Feedback on OMDT

Given below are the analysis of students’ feedback obtained from the OMDT Moodle shell.

Figure 22: Chart of students’ preference of the mode of test in Semester 2, 2015.
Sample - 761 students

Do you prefer the online test or paper-based test

- 37% Online
- 63% Paper-based

Figure 23: Chart of students’ preference of the mode of test in Semester 1, 2016.

Sample - 863 students

Were the test instructions clear and easy to follow?

- 87% Yes
- 13% No

Figure 24: Chart of students’ response on ability to follow the test instructions in Semester 2, 2015.

Sample - 761 students
Figure 25: Chart of students’ response on ability to follow the test instructions in Semester 1, 2016.

Sample – 863 students

Figure 46: Chart showing students’ views of the remedial activities in Semester 2, 2015.

Sample-68 students
Figure 27: Chart showing students’ views of the remedial activities in Semester 1, 2016.

Sample - 192 students

Figure 28: Chart showing students’ views if the remedial is suitable for independent learning in Semester 2, 2015.

Sample – 68 students
Figure 29: Chart showing students' views if the remedial is suitable for independent learning in Semester 1, 2016.

Sample – 192 students

Figure 50: Graph showing students' satisfaction of the videos in Semester 2, 2015.

Sample – 68 students
Figure 31: Graph showing students’ satisfaction of the design and structure of the remedial in Semester 1, 2016.

Sample – 192 students

7.4.1 Students’ Comments:

- Thank you very much for making us learn this way
- Good way of learning
- The notes and examples were easy to understand, and the videos were very clear and understandable
- The remedial is well structured to help students for extra learning
- I find it very helpful and easy to access. Keep it up this good work
- This has really helped me a lot
- Excellent
- The test was very helpful and a big thumb up for the videos, it was easy to understand thus very helpful. Thank you!
- The notes given were very helpful with regards to concepts that were forgotten
- I think it’s very useful and should continue to encourage students to do them
- Very helpful remedial

8 Recommendation

- Have intellectual property protection for OMDT
- Add more questions to test and remedial

9 Conclusion
The OMDT is a great accomplishment for the Faculty of Science, Technology and Environment. Its primary aim is to diagnose and bridge the numeracy gap which originates when students transit from secondary level to tertiary level education system. With the geographical spread of all the member countries which make up USP, a fully functional online system such as OMDT serves its purpose well by unifying all the mathematical variations found within the region to a common standard that helps students to better prepare themselves for university level studies.

10 Publications

- B. Sharma, *An Intelligent Online Diagnostic Tool in Mathematics for Higher Education in Pacific*, PCF8 - Pan-Commonwealth Forum, 27-30 November, Malaysia, 2016. (Accepted)

11 Reference


Appendix 1

Certificate Implementations and Testing

FSTE OMDT Certificate

Overview

The FSTE OMDT certificate will be available to students on the OMDT shell on Moodle. Once a student completes the OMD test by doing the test/retest modules, the student is eligible to get a certificate. The certificate is divided into levels of distinction, credit, pass and participation where the level is based on mark ranges which are similar to mark ranges for grades at USP.

The certification process involves setting up proper conditions for the quiz activities, formula for marksheet and also requires a certificate module to be used in the OMDT shell.

Custom Design

The certificate is custom designed and is in-line with the design given by USP DMCA office.

Testing Certificate Module on Local Machine

1. Moodle 2.9 has be used to test the certificate module. The certificate module is obtained from https://moodle.org/plugins/view/mod_certificate

2. Once installed, the module is in <public web directory>/moodle/mod/certificate/

3. The certificate module has 3 important directories which are used:
   - <public web directory>/moodle/mod/certificate/type
   - <public web directory>/Moodle/mod/certificate/Lang/end
   - <public web directory>/Moodle/mod/certificate/pix

4. A new directory was created by the name fste_omdt with all relevant files and is placed in <public web directory>/Moodle/mod/certificate/type/

5. The certificate.php file in <public web directory>/Moodle/mod/certificate/Lang/end/ was appended with new lines of code.
6. In the border, seals, signatures and watermarks directories in `<public web
directory>/Moodle/mod/certificate/pix/` images were put into them.

The end product of the above steps is a custom FSTE OMDT certificate in .pdf which is available for a student to view and download and the level of certificate will be based on the overall mark the student has obtained in the test. A sample certificate is attached.

**Putting the Certificate into Production**

The following tasks are requested to be carried out on the Moodle server to be able to put the certificate into production and to be usable by the OMDT team.

1. Place the `fste_omdt` directory into `<public web directory>/Moodle/mod/certificate/type/`
2. Append the following lines of code to `certificate.php` in `<public web
directory>/Moodle/mod/certificate/Lang/end/`

```php
// Strings added for FSTE OMDT

$string['type_fste_omdt'] = 'FSTE OMDT';

$string['title_distinction'] = 'Certificate of Distinction';

$string['title_credit'] = 'Certificate of Credit';

$string['title_pass'] = 'Certificate of Pass';

$string['title_participation'] = 'Certificate of Participation';

$string['fste'] = 'FACULTY OF SCIENCE, TECHNOLOGY AND ENVIRONMENT';

$string['person'] = 'Dr. Bibhya Sharma';

$string['person_title'] = 'Associate Dean L&T';

$string['statement-success'] = 'has successfully completed the course';
```
3. Place the border, seals, signatures and watermarks images into their respective directories in `<public web directory>/Moodle/mod/certificate/pix/`.

The changes made in the manner above should not affect the existing certificate designs and logic of issuing out certificate for any other course.

The `fste_omdt` directory and the images are attached.
Appendix 2

Social Authentication Implementations and Testing

**Plugins Added**

Name: auth_googleoauth2  
Version: 2015110600  
Function: Allows users to use their social media account to login to OMDT Moodle.  
([https://moodle.org/plugins/auth_googleoauth2](https://moodle.org/plugins/auth_googleoauth2))  
Note: This plugin was customized partially in order to meet our needs.

Name: block_omdt_custom_register  
Version: 2015121700  
Function: Ensures that the user fills in his/her form that needs to be filled if he/she is logging in using auth_googleoauth2 for the first time. Prevents users from bypassing the form page.  
(Created from scratch by Hyunwook Kim)

**Newly Added Files in auth_googleoauth2**
As shown in the image, Moodle is the root directory of the Moodle web application file structure. From the root directory, the googleoauth2 is the added plugin, and inside it, a new folder named custom was created, and the folder & files as highlighted as shown in the image were also added for the purpose of our customized feature.

These are files that prompt users to fill the form that they need to fill when logging in through googleoauth2 for the first time, validate data in the form, and store them into the database. If the users do not agree to fill the form, they are logged out, disallowing them to proceed to the OMDT courses.

**Existing File Changes in auth_googleoauth2**

In auth_googleoauth2, auth.php was altered in order to meet the needs of USP. Initially, it was designed to merely allow users to login using the social APIs. However, USP required users who logged in through the plugin (and therefore the social APIs) to fill in a user form that will provide useful information about the users. Hence the plugin needed to be altered to fit its needs. Line 363 of auth.php was changed to check that the user is a first time user by checking the OMDT Moodle’s database for the user’s mobile phone number. If the user’s mobile phone number did not exist, the user would be redirected to the form for the user to fill in his/her information including the mobile phone number. (If any of the form field is not filled, it will continue to prompt
the user to fill in the fields hence making sure that any user who has filled the form before will not be redirected to the form again). The redirection of the user to the form was also a code change in lines 366 and 367.

```php
// Create event for authenticated user.
$event = \auth_googleauth2\event\user.loggedin::create(  
    array('context' => context_system::instance(),  
        'objectid' => $user->id, 'relateduserid' => $user->id,  
        'other' => array('access_token' => $access_token));
$event->trigger();

// redirection.
if ($firsttimeuser = DB::get_record('user', array('email' => $useremail, 'phone2' => ''))) {
    $urltag = new moodle_url('/auth/googleauth2/custom/form/customform_view.php');
    // We don't delete $SESSION->wantsurl yet, so we get there later.
    } else if (isset($SESSION->wantsurl) and (strpos($SESSION->wantsurl, $CFG->wwwroot) !== 0)) {
        $urltag = new moodle_url($SESSION->wantsurl); // Because it's an address in this site.
    unset($SESSION->wantsurl);
    } else {
        // No wantsurl stored or external - go to homepage.
        $urltag = $CFG->wwwroot.'/';
        unset($SESSION->wantsurl);
    }
```

Lines of code change that were merely to check and redirect to the form are highlighted in the image.

**Structure of block_omdt_custom_register**

![Structure of block_omdt_custom_register](image)

References to the block structure can be found in the Moodle developer’s website:

[https://docs.moodle.org/dev/Blocks](https://docs.moodle.org/dev/Blocks)
Appendix 3

Guide to access OMDT

Getting Started
Locating OMDT on the Web

1. Open Mozilla Firefox/ Chrome/ Safari/ IE/ or any other browser available on your Computer. [Recommended browser: Mozilla Firefox].

2. Enter the URL http://omdt.usp.ac.fj/ in the address bar of the browser and press Enter.

3. The following web page will appear on your screen.

Log in

In order to access the OMDT, the users are required to enter their credentials.
1. Click on the *Log in* link which can be found on the top right corner of the page.

2. The link will redirect you to the following page.

3. If you are a registered user follow these steps to start continuing your OMDT else see the [Registration](#) process.
   [Recommended Log-in: use your student ID and password]
   
   I. Type your user id and password in the given text fields.
   II. Click the **Log in** button.
   III. After successful login, homepage will be displayed.
Registration
If you have not registered yet, then you can easily log in through your Facebook or your Google+ account. The links are located below the log in button.

Registration process:

1. Click on log in with Google/Facebook.
2. You will be redirected to the following pages.

   For Google accounts
   I. Enter your Email ID and click next.
   II. Enter your password and click Sign in.
III. Following page will appear on screen. Click on allow button to permit OMDT to view your basic information.
For Facebook account:

I. Enter your ID and password in the text fields.

II. Click “log in” button.

III. Upon the successful log in, the following pop-up message will appear on your screen.

IV. Click ok to continue.
3. You will be then redirected to user information form. Fill the accurate information in the required fields and click save changes.

4. **Note**: the information you fill in the text boxes will be used for your certificate. Make sure correct information is used.
Forgot your credentials
If you forgot your username or password then click on the link provide below the log in button.

The following page will be displayed. To reset your password, submit your username or your email address below. If your details are in the database, an email will be sent to your email address, with instructions how to get access again.
OMDT Test

1. Once you are logged in, you will be able to see your ID at the top right corner of your screen. Now you will need to locate your facility's OMDT: Online Mathematics Diagnostic Tool course on the home page. Different OMDT is assigned to different facilities. For instance, if you are enrolled under FSTE, then you need to select OMDT: Online Mathematics Diagnostic Tool (FSTE)
2.
2. If you cannot locate the list of Courses then click “Site Home” button that is located left hand side of the page.

3. Once you click the link, you will be asked to enrol in the course. Click the “enrol me” button to enter into the OMDT course shell.
4. Now you are in the OMDT Course shell. Please read the information and watch the video on this page about how to take the test. Note that the test will only open up if you complete reading all the information and watching the video on this page.
You can start your quiz after looking at procedures in OMDT. Click on the link call "PROCEEDURES In DOING OMDT" located below the video.

**Note:**

Once you have looked at OMDT procedures, the box will be checked in. This indicates that you can proceed further.

**Modules**

There are a total of 5 modules to attempt. In order to attempt the next module, you need to complete and submit the preceding module.
How to attempt it?

1. Click on the given link under each module to start your test.

   MODULE 01

   Algebra

   ✔ Algebra Test

2. Once you have clicked it then you will be able to see quiz instructions on your screen. After reading it, hit button to proceed.

   Algebra Test

   This quiz tests your knowledge on Algebra.

   QUIZ INSTRUCTIONS:
   - There are 8 questions in this quiz.
   - You have 15 minutes to do this quiz.
   - You ONLY get 1 attempt.
   - You must achieve at least 50% to pass this test and earn 2 star.

   GOOD LUCK 😊

   Attempts allowed: 1

   Attempt quiz now

3. The following pop-up message will appear for confirmation. Click “Start attempt” to continue.
4. As soon as you start the attempt. You will be able to see question on screen. At the left corner of your screen you will see a box called **QUIZ NAVIGATION**, this will allow you to navigate through the quiz.

Once you select an option, click **next**.
5. After attempting all the questions, press “Finish attempt” link located in the quiz navigation box then you will be able to see “summary of attempt”. Click “submit all and finish” to finish the test.

6. Pop-up message will appear to confirm the submission. Again click “Submit all and finish” to grade your attempt.

Note: once you submit, you will no longer be able to change your answers for this attempt.

7. You will then able to see your quiz marks. Click “Back to course” to move to next module.
8. If you fail any of the modules, warning will appear under that module.

MODULE 01

Algebra

Warning! Looks like you need some help in this particular topic. Your remedial will be available to you upon completion of all 5 stages of this test.

You should now proceed to Module 2: Functions

Don’t panic... your free remedial will be available to you upon completion of all 5 stages of test.
Questionnaire

After completing the test fill in the questionnaire to give feedback and to get your certificate. This questionnaire will only take 5 minutes of your time. Your feedback is valuable and will help us improve the OMDT project. Click the image to continue.

Certifications and Badge
Upon successful completion of OMDT, you will be awarded a certificate, transcript and a badge.

Help and Support
If you have any queries or questions about the OMDT, or if you wish to report a problem, please email or call one of the following people. Your call will be received by one of the OMDT team member.
Dr. Bibhya Sharma
Associate Professor of Mathematics
Associate Dean – Learning and Teaching
Faculty of Science, Technology and Environment
The University of the South Pacific
Email: bibhya.sharma@usp.ac.fj
Phone: (+679) 3232069
Mobile: 99 89577

Ms. Aluvesi Fonolahi
Student Learning Specialist
Student Learning Support
Faculty of Science, Technology and Environment
The University of the South Pacific
Email: aluvesi.fonolahi@usp.ac.fj
Phone: (+679) 3231729

Mr. Jai Raj
Student Learning Specialist
Student Learning Support
Faculty of Science, Technology and Environment
The University of the South Pacific
Email: jai.raj@usp.ac.fj
Phone: (+679) 3232598

Mr. Akeshnil Bali
Assistant Programmer
Faculty of Science, Technology and Environment
The University of the South Pacific
Email: akeshnil.bali@usp.ac.fj

Mr. Aakash Sharma
Graduate Programmer
Faculty of Science, Technology and Environment
The University of the South Pacific
Email: aakash.sharma@usp.ac.fj